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The FIspace Project 

Leveraging on outcomes of two complementary Phase 1 use case projects (FInest & SmartAgriFood), 
aim of FIspace is to pioneer towards fundamental changes on how collaborative business networks will 
work in future. FIspace will develop a multi-domain Business Collaboration Space (short: FIspace) that 
employs FI technologies for enabling seamless collaboration in open, cross-organizational business net-
works, establish eight working Experimentation Sites in Europe where Pilot Applications are tested in 
Early Trials for Agri-Food, Transport & Logistics and prepare for industrial uptake by engaging with play-
ers & associations from relevant industry sectors and IT industry. 

 

Project Summary 

As a use case project in Phase 2 of the FI PPP, FIspace aims at developing and validating novel Future-
Internet-enabled solutions to address the pressing challenges arising in collaborative business networks, 
focussing on use cases from the Agri-Food, Transport and Logistics industries. FIspace will focus on ex-
ploiting, incorporating and validating the Generic Enablers provided by the FI PPP Core Platform with the 
aim of realising an extensible collaboration service for business networks together with a set of innovative 
test applications that allow for radical improvements in how networked businesses can work in the future. 
Those solutions will be demonstrated and tested through early trials on experimentation sites across Eu-
rope. The project results will be open to the FI PPP program and the general public, and the pro-active 
engagement of larger user communities and external solution providers will foster innovation and indus-
trial uptake planned for Phase 3 of the FI PPP. 
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Abbreviations 

AAA 
Authentication, Authorisation, 
and Accounting 

ACSI 
Artifact-Centric Service Interop-
eration 

AdvB Advisory Board 

AJAX 
Asynchronous JavaScript + 
XML 

API 
Application Programming Inter-
face 

App Software Application 

B2B Business-to-business 

B2C Business-to-Consumer 

BCM 
Business Collaboration Module 
in FIspace 

BCO 
Business Collaboration Objects 
in FIspace 

BE Business Entities 

BPPC 
Business Process Participant 
Configuration 

BSS Business Support Systems 

CDR Charging Detailed Records 

CEP Complex Event Processing 

CSB Cloud Service Bus 

CSS Cascading Style Sheets 

CSV Comma-Separated Values 

D Deliverable 

DAO Data Access Object 

DB Database 

DoW Description of Work 

EC European Commission 

EDI Electronic Data Interchange 

EE Experimentation Environment 

e.g. Exempli gratia = for example 

EPA Event Processing Agent 

EPM 
Event Processing Module in 
FIspace 

ESB Enterprise Service Bus 

EU European Union 

FIA Future Internet Assembly 

FI-PPP 
Future Internet Public Private 
Partnership 

FP7 Framework Programme 7 

GA Grant Agreement 

GE Generic Enabler 

GUI Graphical User Interface 

HTML HyperText Markup Language 

IaaS Infrastructure as a Service 

ICT 
Information and Communication 
Technology 

IDE 
Integrated Development Envi-
ronment 

IDM Identity Management 

i.e. id est = that is to say 

IE Integration Environment 

IEC 
International Electrotechnical 
Commission 

IETF Internet Engineering Task Force 

I/O Input / Output 

IoT Internet of Things 

IP Intellectual Property 

IP (protocol) Internet Protocol 

IPR Intellectual Property Rights 

IPsec Internet Protocol Security 

IT Information Technology 

ITU 
International Telecommunica-
tion Union 

ISO 
International Standardization 
Organisation 

J2SE 
Java 2 Platform, Standard Edi-
tion 

JDK Java Development Kit 

JDT 
Related to Eclipse Java Devel-
opment Tools 

JMX Java Management Extensions 

JRE Java Runtime Environment 

JS JavaScript 

JSON JavaScript Object Notation 

JSP Java Server Page 

JVM Java Virtual Machine 

KPI Key Performance Indicator 

LPA Logistics Planning Application 

M Month 

MTBF Mean Time Between Failures 

MVC Model–View–Controller 

OASIS 
Organization for the Advance-
ment of Structured Information 
Standards 

OAuth 
Open standard Authentication 
protocol 

OMG Object Management Group 

OSS Operational Support Systems 

P2P Peer-to-peer 

PaaS Platform as a Service 

PDE 
Related to Eclipse Java Devel-
opment Tools 

PE Production Environment 

PIA Product Information App 
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PIE 
Preliminary Integration Envi-
ronment 

PKI Public Key Infrastructure 

PM Person Month 

POM 
Project Object Model (used by 
maven tools) 

Proton 
IBM Proactive Technology 
Online 

QoS Quality of Service 

RBAC Role-Based Access Control 

RCP Rich Client Platform 

REST Representational State Transfer 

RFC Request for Comments 

RSS Revenue Sharing System 

RTD 
Research and Technological 
Development 

SaaS Software as a Service 

SDI 
System and Data Integration 
layer in FIspace 

SDK Software Development Kit 

SME 
Small and Medium Sized Enter-
prise 

SOA Service Oriented Architecture 

SOAP Simple Object Access Protocol 

SOA-RM 
(OASIS) Reference Model for 
Service Oriented Architecture 

SPT 
Security, Privacy and Trust 
Framework 

SSH Secure Shell 

SSL Secure Sockets Layer 

SSO Single Sign On 

ST Sub-Task 

SWT Standard Widget Toolkit 

T Task 

TCP Transmission Control Protocol 

TIC 
Tailored Information for Con-
sumers 

TLS Transport Layer Security 

TPM Transport Planning Module 

UAA 
User Management, Authentica-
tion and Authorisation 

UI User Interface 

UML Unified Modeling Language 

URI Universal Resource Identifier 

URL Universal Resource Locator 

USDL 
Unified Service Description 
Language 

VM Virtual Machine 

VPN Virtual Private Network 

W3C World Wide Web Consortium 

WADL 
Web Application Description 
Language 

WLAN Wireless Local Area Network 

WP Work Package 

WS Web Service 

WSDL 
Web Services Description Lan-
guage 

XLS/XLSX Microsoft Excel file Format 

XML eXtensible Markup Language 

XSD XML Schema Definition 
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1 Introduction 

The aim of this document is to describe the main functionalities of the FIspace Software 
Development Kit (SDK) presented as a user and developer guideline related to the envi-
ronment of development and corresponding Integrated Development Environment (IDE) 
based on Eclipse [20] SDK tools for Java. This document describes the functionalities, 
wizards, FIspace Eclipse plugins developed and provided by FIspace SDK to facilitate 
the tasks of the developers through a set of graphical user interface (GUI) which allows 
the developer to interact with the tools, following the necessary steps to achieve the 
desired work or carry out some tasks and testing purposes. 

It is foreseen for the next releases, a chapter for the libraries that are being implement-
ed in several programming languages, in order to provide the FIspace user with the ap-
propriate tools to connect to the platform. 

This document is an annex of the main deliverable D200.7 “FIspace Integrated Release 
V3” in addition to other documents and resources related to the FIspace Project 
([7][8][9][10][11][12][13][14]). The online documentation for SDK is also available in the 
following web site: http://dev.fispace.eu/doc/wiki/sdk  

The following sections are dedicated providing a user guideline and describing the 
steps using the features or functionalities related to each plugin which conform the 
FIspace SDK. It is structured as follows 

 A short description of the plugin and corresponding prerequisites. 

 A set of pictures displaying the user interaction with the Graphical User Interface 
(GUI) by using the corresponding plugin. 

 A set of pictures and descriptions presenting the steps to carry out the desired 
functions as well as providing indications and settings at user level. 

1.1 Scope 

FIspace SDK is a collection of plugins developed for the Eclipse platform which together 
offers an IDE for the development of applications in FIspace. In this environment it's 
possible to edit different codes, scripts with syntax highlight, code completion, compila-
tion errors, code and comment folding, script execution with pre-configured interpreters, 
alongside with the tools which are already provided by the Eclipse platform. 

Seventeen FIspace plugins have been already implemented. The FIspaceStudio 
Tool is also available. This binary distribution of FIspace SDK is represented by an 
Eclipse Rich Client Application. The distribution provides the required user interface for 
all of the pre-installed FIspace SDK functionalities along with a customised approach of 
the Eclipse IDE reaching the specific needs of FIspace platform. 

Several libraries to access FIspace platform are being implemented in different pro-
gramming languages (C#, JavaScript and Python libraries are in progress. PHP library 
is also planned). The aim of these libraries is to provide the corresponding access to 
FIspace services based on OAuth2 protocol [26]. 

The following plugins are available for the application developer: 

 FIspace Preferences: special dialog pages to indicate how FIspaceStudio is go-
ing to operate. 

http://dev.fispace.eu/doc/wiki/sdk
https://www.eclipse.org/
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 FIspace Perspective: defines the initial set of FIspace collection and arrange-
ment of views, and its editor area. 

 FIspace Views: the set of views are provided with the FIspaceStudio. 

 Create a project: a FIspace wizard has been implemented. Five archetypes 
have been defined to generate the different FIspace projects. 

Exclusively for projects based on the Widget nature (widget projects and widget 
part in decoupled projects), and once the development of the widget is complet-
ed, the user will be able to validate the project and then to upload it to FIspace 
Store. 

 Generate project documentation: provides the Java doc generation by FIspace 
using maven ([21]) capabilities in Eclipse. 

 Using the Acsi Editor - BCO (Business Collaboration Objects): provides the 
ACSI (Artifact-Centric Service Interoperation [24]) editor tool to FIspace develop-
ers. ACSI editor is a web based tool used by BCM module of B2B component for 
the creation of business entities. 

 Using the Proton Editor – EPM: to access to PROTON (IBM Proactive Tech-
nology Online) [25], a web-based tool used by EPM module of B2B component 
for the creation of partners and the corresponding events. 

 A File Editor for the Widget Config.xml : allows the user to define its app con-
fig properties in a friendly way. 

 The SDI Connector with the SDI Rest Tool: allows the final user to experiment 
with SDI module locally. This feature is provided with an Eclipse view, allowing 
end-users to test different services in different machines, not only focusing on 
SDI connector plugin. 

 Publish and Subscribe Messages: shows the capabilities of information trans-
mission from different layers and systems through RabbitMQ (open source mes-
sage broker software that implements the Advanced Message Queuing Protocol 
–AMQP-). 

 A Logging Plugin: enables users to store, and classify the logs generated by 
FIspace apps in order to make easy the app development process. Now, a back-
end to store all generated logs in a database is provided. (This back-end is de-
veloped in Nodejs and database in MongoDB [28]) 

 Transforming File Formats: several standard/widely-used data formats can be 
interchanged by means of this plugin. 

 Sketches plugin: allows the user to draw and make some simple diagrams that 
can be useful to depict icons, flow diagrams, component analysis, etc. 

 REST client applications: generates REST clients for the application develop-
ers in an easy way. 

 SOAP client applications: for generating SOAP clients in an automatic and 
transparent way for the end user. 

 FIspace Graphics View: this plugin allows the app developer/designer to use in 
a graphical way the next FIspace plugins: REST/SOAP clients, Publish-

https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/FIspace_Perspective
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_create_a_project
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_generate_project_documentation
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_use_the_AcsiEditor
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_use_the_SDI_Connector
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/the_SDI_Rest_Tool
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_publish_subscribe_a_message
http://en.wikipedia.org/wiki/Message_broker
http://en.wikipedia.org/wiki/Message_broker
http://en.wikipedia.org/wiki/Advanced_Message_Queuing_Protocol
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_use_logging_plugin
https://bitbucket.org/fispace/apps/wiki/tutorial/getting-started/sdk-tutorial/how_to_convert_file_formats
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er/Consumer facilities, and the FIspace Data Transformer. Widget graphic man-
agement is ready for apps being uploaded. 

 Import plugin: new plugin implemented for importing FIspace projects (widget 
and decoupled ones). 

 Export plugin: new plugin implemented for exporting FIspace projects. 

 

Figure 1: FIspace SDK features overview 

 

Table 1 shows the links to the SDK resources and online documentation. 

Description Link 

FIspace App Developer Intro web 
site 

http://dev.fispace.eu/doc/wiki/App%20Develope
r%20Intro 

FIspace SDK Guide web site http://dev.fispace.eu/doc/wiki/sdk 

FIspace apps for newbies https://bitbucket.org/fispace/apps/wiki/FIspace%
20apps%20for%20newbies  

Table 1: FIspace SDK resources and online documentation 

 

  

http://dev.fispace.eu/doc/wiki/App%20Developer%20Intro
http://dev.fispace.eu/doc/wiki/App%20Developer%20Intro
http://dev.fispace.eu/doc/wiki/sdk
https://bitbucket.org/fispace/apps/wiki/FIspace%20apps%20for%20newbies
https://bitbucket.org/fispace/apps/wiki/FIspace%20apps%20for%20newbies


FIspace 27.02.2015 

Deliverable D200.7 Annex SDK User-Developer Guide Page 14 of 108 

Table 2 shows the links to other online resources related to FIspace project and FI-
WARE. 

Description Link 

FIspace Business collaboration web 
site 

http://www.fispace.eu/ 

FIspace Developer Documentation 
web site 

http://dev.fispace.eu/doc/wiki/Home 

FIspace Deliverables web site http://www.fispace.eu/deliverable.html 

FIspace Tutorial web site http://www.fispace.eu/tutorials.html 

FIWARE web site http://www.fi-ppp.eu/projects/fi-ware/ 

FIWARE Catalogue of the Generic 
Enablers (GEs) 

http://catalogue.fi-ware.org/ 

FIWARE community web site http://www.fi-ware.org/community/ 

Table 2: Other FIspace and FIWARE resources 

 

Table 3 shows the links to the Wirecloud online documentation. 

Description Link 

FIWARE - Catalogue - Application 
Mashup - Wirecloud 

http://catalogue.fi-ware.org/enablers/application-
mashup-wirecloud  

FIWARE - Catalogue - Application 
Mashup - Wirecloud Documentation 

http://catalogue.fi-ware.org/enablers/application-
mashup-wirecloud/documentation  

FIWARE - Application Mashup - 
Wirecloud - User and Programmer 
Guide 

https://forge.fi-
ware.org/plugins/mediawiki/wiki/fiware/index.ph
p/Application_Mashup_-_Wirecloud_-
_User_and_Programmer_Guide  

Dashboard - Wirecloud home page http://conwet.fi.upm.es/wirecloud/  

Dashboard - The WireCloud 
Mashup Platform 

http://conwet.fi.upm.es/docs/display/wirecloud/T
he+WireCloud+Mashup+Platform  

Dashboard - Welcome to CoNWeT-
Wirecloud Confluence 

http://conwet.fi.upm.es/docs/dashboard.action  

Dashboard - User Guide http://conwet.fi.upm.es/docs/display/wirecloud/
WireCloud+User%27s+Guide  

Dashboard - WireCloud Installation 
and Administration Guide 

http://conwet.fi.upm.es/docs/display/wirecloud/
Wire-
Cloud+Installation+and+Administration+Guide  

Table 3: Wirecloud online documentation 

http://www.fispace.eu/
http://dev.fispace.eu/doc/wiki/Home
http://www.fispace.eu/deliverable.html
http://www.fispace.eu/tutorials.html
http://www.fi-ppp.eu/projects/fi-ware/
http://catalogue.fi-ware.org/
http://www.fi-ware.org/community/
http://catalogue.fi-ware.org/enablers/application-mashup-wirecloud
http://catalogue.fi-ware.org/enablers/application-mashup-wirecloud
http://catalogue.fi-ware.org/enablers/application-mashup-wirecloud/documentation
http://catalogue.fi-ware.org/enablers/application-mashup-wirecloud/documentation
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Application_Mashup_-_Wirecloud_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Application_Mashup_-_Wirecloud_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Application_Mashup_-_Wirecloud_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Application_Mashup_-_Wirecloud_-_User_and_Programmer_Guide
http://conwet.fi.upm.es/wirecloud/
http://conwet.fi.upm.es/docs/display/wirecloud/The+WireCloud+Mashup+Platform
http://conwet.fi.upm.es/docs/display/wirecloud/The+WireCloud+Mashup+Platform
http://conwet.fi.upm.es/docs/dashboard.action
http://conwet.fi.upm.es/docs/display/wirecloud/WireCloud+User%27s+Guide
http://conwet.fi.upm.es/docs/display/wirecloud/WireCloud+User%27s+Guide
http://conwet.fi.upm.es/docs/display/wirecloud/WireCloud+Installation+and+Administration+Guide
http://conwet.fi.upm.es/docs/display/wirecloud/WireCloud+Installation+and+Administration+Guide
http://conwet.fi.upm.es/docs/display/wirecloud/WireCloud+Installation+and+Administration+Guide
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Table 4 shows the links to the WStore online documentation. 

Description Link 

FIWARE - Catalogue - Store - 
WStore 

http://catalogue.fi-ware.org/enablers/store-
wstore  

FIWARE - Catalogue - Store - 
WStore Documentation 

http://catalogue.fi-ware.org/enablers/store-
wstore/documentation  

FIWARE - Store - W-Store - User 
and Programmer Guide 

https://forge.fi-
ware.org/plugins/mediawiki/wiki/fiware/index.ph
p/Store_-_W-Store_-
_User_and_Programmer_Guide  

FIWARE - Store - W-Store - Store - 
W-Store - Installation and Admin-
istration Guide 

https://forge.fi-
ware.org/plugins/mediawiki/wiki/fiware/index.ph
p/Store_-_W-Store_-
_Installation_and_Administration_Guide  

Table 4: Store online documentation 

 

Table 5 shows the external development tools references. 

Description Link 

Java Environment, JVM, JRE, JDK 
(Oracle) 

http://www.oracle.com/technetwork/java/javase/
downloads/index.html  

Eclipse IDE (Integrated Develop-
ment Environment) 

https://www.eclipse.org/ , 
https://www.eclipse.org/downloads/ 

Maven http://maven.apache.org/ , 
http://maven.apache.org/download.cgi 

Table 5: External development tools references 

 

Table 6 shows the FIspace development repository and documentation references 
based on the bitbucket tools for collaborative development. 

Bitbucket is a hosting site for the distributed version control systems (DVCS) Git 
(http://git-scm.com/) and Mercurial (http://mercurial.selenic.com/). The service offering 
includes an issue tracker and wiki, as well as integration with a number of popular ser-
vices such as Basecamp, Flowdock, and Twitter. 

 

Description Link 

Bitbucket FIspace repository home 
page 

https://bitbucket.org/fispace 

http://catalogue.fi-ware.org/enablers/store-wstore
http://catalogue.fi-ware.org/enablers/store-wstore
http://catalogue.fi-ware.org/enablers/store-wstore/documentation
http://catalogue.fi-ware.org/enablers/store-wstore/documentation
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_User_and_Programmer_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_Installation_and_Administration_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_Installation_and_Administration_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_Installation_and_Administration_Guide
https://forge.fi-ware.org/plugins/mediawiki/wiki/fiware/index.php/Store_-_W-Store_-_Installation_and_Administration_Guide
http://www.oracle.com/technetwork/java/javase/downloads/index.html
http://www.oracle.com/technetwork/java/javase/downloads/index.html
https://www.eclipse.org/
https://www.eclipse.org/downloads/
http://maven.apache.org/
http://maven.apache.org/download.cgi
http://git-scm.com/
http://mercurial.selenic.com/
https://confluence.atlassian.com/display/BITBUCKET/Use+the+issue+tracker
https://confluence.atlassian.com/display/BITBUCKET/Use+a+wiki
https://confluence.atlassian.com/display/BITBUCKET/Manage+Bitbucket+hooks
https://confluence.atlassian.com/display/BITBUCKET/Manage+Bitbucket+hooks
https://bitbucket.org/fispace
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Bitbucket FIspace core component 
home page 

https://bitbucket.org/fispace/core/wiki/Home  

Bitbucket FIspace Roadmap page https://bitbucket.org/fispace/core/wiki/roadmap  

Table 6: Bitbucket collaborative environment for FIspace development 

 

This document is the initial guideline for the SDK. More updated information can be 
found on the FIspace online documentation. 

Online documentation for SDK [12][13]: http://dev.fispace.eu/doc/wiki/sdk  

1.2 Intended audience 

The main interest groups of this document are the software developers or users who 
are developers of application for FIspace or by extension they are App developers on 
top of the FIspace platform. App Developers are the actual software and system provid-
ers who offer “packaged” / componentized solutions and applications in form of Apps. 

https://bitbucket.org/fispace/core/wiki/Home
https://bitbucket.org/fispace/core/wiki/roadmap
http://dev.fispace.eu/doc/wiki/sdk
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2 SDK User/Developer Guide 

2.1 Goal and objectives 

The Software Development Toolkit (SDK) provides tool-support for the development of 
FIspace Apps. The SDK will ease the work of App developers during the implementa-
tion of the Apps, providing specific tools and hiding the complexity of the platform. Par-
ticularly, the SDK will include: 

 Tooling (specifically an Integrated Development Environment – IDE), which is 
built on Eclipse IDE [20]. Eclipse is widely adopted by the development commu-
nity and supported by the Eclipse foundation. The FIspace SDK will offer func-
tionalities such as (1) integration of Eclipse JDT (Eclipse Java Development 
Tools) (e.g., classpath containers) or Eclipse PDE (Eclipse Plug-in Development 
Environment); (2) providing access to Javadoc for all referenced elements 
(FIspace modules) and auto-completion support; (3) visual management of com-
ponents and case modelling will be provided. 

 Libraries to link with the respective modules of the FIspace, such as security, pri-
vacy and trust, or the System and Data Integration layer in FIspace (SDI). 

Complementing the SDK, there will be a set of tools targeted to business architects for 
customizing and extending the FIspace to the individual needs of Users. This includes 
tools for authoring of Business Entities and Event Rules (see B2B Core), as well as 
configuring mediators and connectors to backend systems (see System and Data Inte-
gration). 

2.2 Overview 

As an initial precondition it is recommended to start working on a new Eclipse [20]. 
When trying to install the FIspace SDK plugins into older versions of Eclipse, depend-
ency conflicts may occur during installation. Therefore it is highly recommended to 
download a current version of Eclipse from https://www.eclipse.org/downloads/ , and to 
remove your local repository. 

Once the Eclipse product is running, the first step will be to install the FIspace plugins 
using the FIspace update site (http://37.131.251.110:8080/fispace-updatesite/): select 
Help -> Install New Software -> Install the FIspace Update Site. 

 

https://www.eclipse.org/downloads/
http://37.131.251.110:8080/fispace-updatesite/
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Figure 2 shows the FIspace SDK screenshot as an overview. 

 

Figure 2: FIspace SDK screenshot overview 
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2.3 FIspace-bcoeditor Plugin 

BCO (Business Collaboration Objects) can be accessed by an icon on the Eclipse IDE 
toolbar as well as with an entry under “FIspace” menu category. 

The user clicks either on the toolbar button or on the menu entry in order to trigger the 
Eclipse internal browser which automatically loads the ACSI [24] tool web page, as it is 
shown in the following figures: 

 

Figure 3: Menu item to access the BCO Editor 

 

 

Figure 4: FIspace BCO editor 
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2.4 FIspace-converter Plugin 

2.4.1 Prerequisites 

We have the possibility of convert among different file formats like XML, JSON, CSV, 
XLS/XLSX (Microsoft Excel file Format) and EDI, between others. The only prerequisite 
is to have one of these documents to convert Copying & Pasting into the text area or 
uploading the file from the local disk. 

2.4.2 Using the plugin 

From the FIspace menu bar, select the option Format Converter. 

 

Figure 5: FIspace converter 

2.4.3 Converting formats 

This tool offers the opportunity of choosing among different formats in order to convert-
ing them into others. The source format can be selected from the main combo box. 

 

Figure 6: Format converter dialog (I) 
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Once the source format has been selected, another combo box has to be used for se-
lecting the target format in the “Conversions” section. 

 

Figure 7: Format converter dialog (II) 

In order to make the format transformation, we must copy and paste the data to trans-
form in the text area placed at left. 

 

Figure 8: Format converter dialog (III) 
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At this moment we can push the button to convert the format. The result will appear into 
the text area placed at the right. 

 

Figure 9: Format converter dialog (IV) 

 

In any moment, we can clear the content of the controls using the Clear button. 

The operation to convert Excel formats to other formats works differently. We can't do 
copy & paste from an Excel file into the text area. For this reason, we need to upload 
the file from the local directory using the conversion button (arrow button) placed be-
tween the text areas. After of this, the file uploaded is converted to the desired format. 

 

Figure 10: Format converter dialog (V) 
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The result of the conversion is showed into the text area at right. 

 

Figure 11: Converting XLSX to JSON 
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2.5 FIspace-doc Plugin 

FIspace Doc is an Eclipse Plugin for automatically adding Maven [21] Site and POM 
file headers to your default workspace or directly to any folder. It optionally generates 
initial comments from the elements name by using Velocity templates for Javadoc and 
file headers. 

 

Figure 12: FIspace doc generator 

 

The results are shown in next figure. 

 

Figure 13: FIspace doc generation results 
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Setting of the project Workspace. 

 

Figure 14: FIspace Doc dialog (I) 

 

Setting of the maven tools related to the project. 

 

Figure 15: FIspace Doc dialog (II) 
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FIspace Doc plugin has the following features: 

 Workspace Tab: Generate the documentation directly of the workspace projects. 

 

Figure 16: FIspace Doc Workspace tab (I) 

 

 Generate all projects: Calls the maven site build on every project. 

 

Figure 17: FIspace Doc Workspace tab (II) 

 

 Generate projects: Calls the maven site on selected projects. 

 

Figure 18: FIspace Doc Workspace tab (III) 
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 Direct Tab options. 

 

Figure 19: FIspace Doc Direct tab (I) 

 

 Project or Folder: Generate the maven site directly to any folder. Existing site will 
be totally replaced by the generated. 

 Generation Options: 

o External: It generates documentation by External Maven. 

o Embedded: It generates documentation by Embedded Maven. 

o Usage: Browse the project location 

 

Figure 20: FIspace Doc Direct tab (II) 
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Action to select the Generation type: 

 

Figure 21: FIspace Doc Direct tab (III) 

 

Press OK Button to validate the options and generate the documentation. 

 

Figure 22: FIspace Doc Direct tab (IV) 
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If everything was successful the results appear like follows: 

 External 

 

Figure 23: External Generation result 

 Embedded 

 

Figure 24: Embedded Generation result 

Validations: The "Project" field is mandatory. 

 

Figure 25: FIspace Doc validations (I) 
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Set the MAVEN_HOME environment variable to point to the Maven installation for gen-
eration with External Maven. 

 

Figure 26: FIspace Doc validations (II) 

 

2.6 FIspace-epmeditor Plugin 

EPM editor can be accessed by an icon on the Eclipse IDE toolbar as well as with an 
entry under “FIspace” menu category. 

The user can click either on the toolbar button or on the menu entry in order to trigger 
the Eclipse internal browser which automatically loads the Proton tool web page [25]. 

 

Figure 27: FIspace EPM editor 

 

Notice that the EPM editor could not be opened with the Eclipse internal web browser 
(more memory resource could be needed). Try instead with an external web browser. 
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2.7 FIspace-export Plugin 

To export an entire FIspace project into an archive or directory, follow these steps: 

Select the project then right click over the project: 

 

Figure 28: FIspace Export 

After clicking over Export option, the following dialog will appear: 

 

Figure 29: FIspace Export Options (I) 
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The user should select FIspace then Export FIspace Project: 

 

Figure 30: FIspace Export Options (II) 

 

By clicking on button Next, a form will appear: 

 

Figure 31: FIspace Export Wizard 
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The user should fulfill the form then click on button Finish: 

 

 

Figure 32: FIspace Project to be exported 
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2.8 FIspace-graphic Plugin 

The FIspace Graphic is a fancy and easy-to-use graphic plugin that will help you to en-
hance the level of detail of how to use the SDK. 

Open the FIspace graphic Perspective by using the standard Window -> Open Per-
spective -> Other.Command and selecting "FIspace (Graphics)” from the list. 

 

Figure 33: FIspace Graphics perspective 

 

The perspective will open two views (see next figure): 

 A "FIspace Graphic" browser view to the left containing different FIspace ele-
ments. 

 A "FIspace Visual:" canvas view to the right containing the elements dropped 
from FIspace Graphic Explorer. 

 

 

Figure 34: FIspace Graphics Overview 
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2.8.1 The Browser Pane 

This is the browser pane, where you can navigate through different FIspace elements. 
This pane list all the elements of FIspace as a tree view also the User could drag and 
drop the elements from the browser to the Canvas and then start to interact with these 
(see next figure). 

 

Figure 35: FIspace Graphic Explorer 

2.8.1.1 Web Services 

This element helps to interact with the REST and SOAP plugins. 

 

Figure 36: Web Services Element 

REST Client Generator 

Through this element the user could create, consume and test REST web services. 

REST Client from file 

Dragging and dropping a REST client from file: 
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Figure 37: REST client from file 

After double clicking over the graphic element came up a form with REST web service 
details: 

 

Figure 38: REST client form (I) 

After setting all data from the form, FIspace generate the REST web services from the 
file (WADL Endpoint - Browse). 

REST Client from URL 

Dragging and dropping a REST client from URL: 
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Figure 39: REST client from URL 

After double clicking over the graphic element came up a form with REST web service 
details: 

 

Figure 40: REST client form (II) 

After set all data from the form, FIspace generates the REST web services from the 
URL (WADL Endpoint). 

SOAP Client Generator 

Through this element the user could create, consume and test SOAP web services. 

SOAP Client from file 

The picture of the SOAP Client on the FIspace Visual: Web Services: 
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Figure 41: SOAP client from file 

After double clicking over the graphic element came up a form with SOAP web service 
details: 

 

Figure 42: SOAP client form 

After setting all data from the form, FIspace generates the SOAP web services from the 
file (WADL Endpoint - Browse). 

SOAP Client from URL 

The picture of the SOAP Client on the FIspace Visual: Web Services: 



FIspace 27.02.2015 

Deliverable D200.7 Annex SDK User-Developer Guide Page 39 of 108 

 

Figure 43: Rest client from URL 

After double click over the graphic element came up a form with SOAP web service de-
tails: 

 

Figure 44: SOAP client form 

After setting all data from the form, FIspace generates the SOAP web services from the 
URL (WADL Endpoint). 

2.8.1.2 Publish/Subscribe 

The main objective of distributed event-based systems is to decouple the system’s 
components (producers/consumers) therefore FIspace has added this feature (Publish-
er and Subscriber). 

 

Figure 45: Publish/Subscribe Elements 
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Figure 46: Publish/Subscribe on FIspace Canvas 

Prerequisites 

Messages are published and subscribed by use RabbitMQ Server. In case of work with 
a local server is necessary to download and install RabbitMQ from: 
http://www.rabbitmq.com/download.html 

FIspace Publisher 

In order to publish the user should double click over the FIspace_Publisher graphic el-
ement then a form appears with the parameters details.  

 

 

http://www.rabbitmq.com/download.html
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Figure 47: Publisher Form 

After set all data from the form, the user should send the information to the server 
(RabbitMQ) by clicking on the Publish button. 

FIspace Subscriber 

Exist two ways how to subscribe the messages: 

Through the Visual Canvas: 

Selecting the Publisher and Subscriber by the option connect from the toolbar: 

 

Figure 48: Option Connect 

 

Figure 49: Connect Publisher/Subscriber 
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After connecting the user should insert the Publisher data then the data in the Sub-
scriber is going to be updated automatically: 

 

Figure 50: Publisher/Subscriber Form 

Through Setting the Data Manually: 

The user should insert the Publisher data the Subscriber data manually:  

 

Figure 51: Publisher and Subscriber not connected 
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Figure 52: Fulfilling the Publisher/Subscriber settings manually 

Clicking the button Subscribe the user is going to receive the message: 

 

Figure 53: Click on Subscribe button 

2.8.1.3 Endpoints 

The FIspace Endpoints provide a reference or specification that is used to define a 
group or family of message addressing properties and give end-to-end message char-
acteristics. 

 

Figure 54: Endpoints elements 
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Figure 55: Endpoints on FIspace Visual 

2.8.1.3.1 Types of Endpoints 

FIspace supports two types of Endpoints FI-Ware and Widget. 

Fi-Ware Endpoints 

Through this element the user could reach and work with FI-Ware Endpoints. 

Widgets 

Through this element the user could reach and work with Widgets. The FIspace Widget 
element Form has two TabFolders: Widget Settings and Graphic Settings. 

The user could specify Widget settings: 

 

Figure 56: Widget Form – Tab Widget Settings 

The user could specify Graphic settings: 
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Figure 57: Widget Form – Tab Graphic Settings 

2.8.1.4 Transformers 

Format Transformation helps the user to convert from several formats into others:. 

 

Figure 58: Transformer formats 

The following figure shows the types of formats/elements that FIspace Graphic sup-
ports. 

 

Figure 59: Type of formats on FIspace Visual 
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2.8.1.4.1 Type of formats 

FIspace supports conversion for XML, CSV, EDI, JSON, XLS, XSD, and XLSX. 

2.8.1.4.2 Form Details 

After double click over an element on the FIspace Visual a form appears: 

 

Figure 60: Format/Element XML Form 

All Elements of the FIspace Transform Form got the same TabFolders. 

Insert by Direct Input 

Basically here the user Cut and Paste the data to transform, see Figure 57. 

 

Figure 61: XML Format – Insert by Direct Input 
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Insert by File Upload 

Basically here the user adds the file to transform: 

 

Figure 62: XML Format – Insert by File Upload 

Output 

If the element is connected already and it is the target format, the user could see the 
result of the transformation here. 

 

Figure 63: XML Format – Output 
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Graphic Settings 

Through this form the user could change the graphic settings. 

 

Figure 64: XML Format – Graphic Settings 

2.8.1.4.3 How to Transform Data 

The next steps are the basic steps to transform any format: 

Drag & Drop 

You have to drag & drop the element to transform from the browser into the Visual 
FIspace also the target element. In this case the source is XML and target JSON. See 
next figure: 

 

Figure 65: XML Format (Source) and JSON Format (Target) 
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Add the Data to Transform 

The user must add the data. Exist two ways how to add the data to transform: Insert by 
Direct Input or Insert by File Upload. In this case The Insert by Direct input was used. 

 

Figure 66: Direct Input 

Connect the Elements 

Selecting the Source (XML) and Target (JSON) by the option “Connect” from the 
toolbar, then the data in the Target is going to be transformed automatically, see Figure 
63. 

 

 

Figure 67: Connect the elements 

Target Tab Output 

After connecting the user should check the Tab Output from the target: 



FIspace 27.02.2015 

Deliverable D200.7 Annex SDK User-Developer Guide Page 50 of 108 

 

Figure 68: Target Output 

The transformation from XML to JSON was successfully done by the Graphic Plugin. 

2.8.2 FIspace Graphics Toolbar 

The FIspace Graphic Toolbar allows the user to work and interact with the FIspace 
Graphic Elements. 

 

Figure 69: FIspace Graphic Toolbar 

 

The FIspace Graphic toolbar elements are: 

Button Pointer 

Through this button the user could deselect the current element selected on the Visual 
Graphic Area, basically this is the on-focus. 

Button Connect 

Through this button the user could connect different elements on the Visual Graphic 
Area. 

Button Save 

Store all the elements on in the Visual Graphic Area and its relations in XML Format. 



FIspace 27.02.2015 

Deliverable D200.7 Annex SDK User-Developer Guide Page 51 of 108 

 

 

Figure 70: FIspace Graphics Persistent Files 

The description of the storage files is following: 

FIspaceStudioConnectionsData.xml File:  

It is produced by flushing the relations between elements on the Visual Graphic Area to 
disk. 

FIspaceStudioDialogData.xml File: 

It is produced by flushing the Dialog data of the elements on the Visual Graphic Area to 
disk. 

FIspaceStudioGraphicsData.xml 

It is produced by flushing the Graphical data of the elements on the Visual Graphic Area 
to disk. 

Button Delete 

Through this button the user could delete different elements on the Visual Graphic Area: 

 

Figure 71: Deleting Elements 
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2.9 FIspace-import Plugin 

You can import FIspace projects in your workspace by means of this plugin extension. 
Select from the main menu File  Import  FIspace  Existing FIspace Project.  

 

Figure 72: FIspace import plugin 

It will then appear a wizard for browsing and selecting the path of the FIspace project to 
be imported on workspace. Once you have chosen the path you can safely import the 
selected project on workspace by clicking on Finish button. 

 

Figure 73: FIspace import wizard 
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2.10 FIspace-perspective Plugin 

The FIspace perspectives can be opened by clicking on the menu bar: Window -> Per-
spective -> Other -> FIspace. 

 

Figure 74: FIspace SDK Perspectives View entry 

If the user selects the FIspace Graphics one, the layout changes to the following: 

 

Figure 75: FIspace Graphics perspective 
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2.11 FIspace-preferences Plugin 

FIspace has a number of preference settings under Window → Preferences  FIspace 
Preferences. 

The FIspace recommended settings are: 

 

Figure 76: FIspace Preferences Settings Form 

Archetypes Settings: 

In short, archetype is a Maven project templating toolkit. The simplest way to get started 
with FIspace is to generate a new FIspace project using the FIspace Wizard. 

In the “Archetype Settings” form the user can provide the configuration of the each 
FIspace Project. 

 

Figure 77: Archetypes Settings Form 
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BCO Settings: 

 

Figure 78: BCO Settings Form 

Logging Settings: 

 

Figure 79: Logging Settings Form 
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Proxy Settings: 

 

Figure 80: Proxy Settings Form 

 

SDI Settings: 

 

Figure 81: SDI Settings Form 
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Uploader Settings: 

 

Figure 82: Uploader Settings Form 
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2.12 FIspace-pubsub Plugin 

2.12.1 Prerequisites 

Messages are published and subscribed using RabbitMQ Server [22]. We can work with 
a remote server specifying an IP address and port or using a domain name, or using a 
local server. In case of work with a local server is necessary to download and install 
RabbitMQ from: http://www.rabbitmq.com/download.html 

2.12.2 Using the plugins 

From the FIspace menu bar, select the option Publish/Subscribe. This option is subdi-
vided in two options, Publish Message or Subscribe Message. 

 

Figure 83: FIspace publisher-subscriber 

Publish and Subscribe are separate plugins. They are working independently each by 
itself. 

2.12.3 Publish a message 

In order to publish a message, we need to specify the following parameters: a queue 
name, an exchange name, the message and an IP with a port or a domain name. See 
the next figure: 

 

Figure 84: Publisher dialog 

http://www.rabbitmq.com/download.html
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2.12.4 Subscribe a message 

In order to subscribe messages, we need also to specify some information, a queue 
name, an exchange name, the message and an IP with a port or a domain name such 
is showed in the next image. Every time a message is sent to the RabbitMQ, the con-
sumer or subscriber captures it and shows the message just received. 

 

Figure 85: Subscriber dialog 
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2.13 FIspace-REST Plugin 

From the Bar menu select File -> New Project -> Rest Client Generator. This wizard 
will be opened: 

 

Figure 86: FIspace REST tool 

If you want to generate a REST client from a file, choose the corresponding item. 

 

Figure 87: FIspace REST tool from file (I) 
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Clicking on Next button the following window is shown (Figure 88). 

 

Figure 88: FIspace REST tool from file (II) 

If you want to generate a REST client from an URL, choose the corresponding item. 

 

Figure 89: FIspace REST tool from URL (I) 
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Click on Next button to continue with the wizard. 

 

Figure 90: FIspace REST tool from URL (II) 
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2.14 FIspace-sdi-connector Plugin 

Once the SDI Connector plugin is installed into the workbench, new elements are add-
ed to the workbench. System and Data Integration layer is a component of FIspace 
architecture. 

A new icon (SDI Connector) will be enabled to launch the SDI Connector plugin. This 
icon can be showed in the following picture. 

 

Figure 91: Button location to launch the SDI Connector plugin 

Also in FIspace menu entry: 

 

Figure 92: Menu item to launch the SDI Connector 

A new Eclipse view associated to the SDI Connector plugin will be accessible. To open 
this new view provided by the plugin, the next steps must be followed: 

Into the main menu select Window -> Show View -> Other; once opened, the FIspace 
view will be available. This view contains a tool called SDI Rest Tool, which will provide 
access to Rest Services for the SDI Connector. 

 

Figure 93: FIspace SDI Rest Tool (I) 
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Selected the view, a new item appears into the workbench. This contains a console 
view to check the status of the SDI plugin and the SDI Rest Tool to manage REST calls. 

 

Figure 94: FIspace SDI Rest Tool (II) 

The behaviour and use of this tool will be explained in the paragraph 2.14.2 “The SDI 
Rest Tool“. 

2.14.1 Using the SDI Connector 

Once explained the items provided by the plugin described in the previous chapter, we 

can launch the SDI Connector by clicking the button defined for that purpose . 

After that, a new window, will inform us about the progress of that launching.  

The SDI connector plugin will perform all the activities required for download, install and 
setup the plugin. During this process it is possible to check its progress by glancing the 
console. If the whole process ends without errors, two events have occurred: 

 The console’s output will show all the information related to the SDI installation. It 
means, therefore any errors occurred as the successful installation. It is shown in 
the next figure: 
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Note that in this case, the plugin has been loaded successfully and no previous 
errors have been produced. 

 Moreover, a new window with the entire rest specification (the WADL file) will be 
shown to the user in aim to provide him the whole REST specification associated 
to the SDI Connector. The picture below shows a snippet of the content of this 
file. 

 

Note: It’s also possible to check the content of this file, accessing with a web browser 
the URL associated to localhost machine: http://localhost:9090/api/application.wadl 

2.14.2 The SDI Rest Tool 

The SDI connector also provides a REST tool for testing purpose. This tool let users 
test REST services against different machines or servers. In this case, this tool let us 
check the SDI services deployed into the local machine. 

http://localhost:9090/api/application.wadl
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Figure 95: FIspace SDI Rest Tool view 

Several items are described as follows: 

 URL: The REST URL to test. This can be a local one or remote one. 

 Go: Start the request defined by URL, method, headers and parameters. 

 Stop: Stop the current request. 

 Type of request: The request can be done using different kind of methods. Fur-
ther information about request methods can be found in the Hypertext Transfer 
Protocol -- HTTP/1.1 at W3C.org. 

 Headers: Defines (if necessary) the headers for the request. If more than one is 
defined, each one must be defined in separate lines. Further information about 
Headers can be found in the Hypertext Transfer Protocol -- HTTP/1.1 at 
W3C.org. 

 Params: Defines, as the previous section, the parameters for the formal REST 
request. In the same way like headers, each parameter should be defined in 
separate lines. Further information about protocol parameters can be found in 
the Hypertext Transfer Protocol -- HTTP/1.1 at W3C.org. 

 Body: HTTP Body Data is the data bytes transmitted in an HTTP transaction 
message immediately following the headers if there is any. Enabling the “Use 

Body Text” option , user can define it.  

It’s possible to use an existing file to provide the content of the body into the request. In 

this case, clicking the “File” button , the user can specify the file, and the type of 
from the local machine. 
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Figure 96: FIspace SDI Rest Tool file dialog 

Further information about message types can be found in the Hypertext Transfer Proto-
col -- HTTP/1.1 at W3C.org. 

Request details panel: Shows information about the kind of request done by the user. 

 

Response Panel: Represent the response obtained after the user request. 
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2.15 FIspace-Sketches Plugin 

We have the possibility, like using a blackboard or note, to draw figures and lines, write 
text and others as a useful tool to define or create sketches about anything that we 
have in mind, and we need to write this in a note or sketch. Moreover, we can save this 
sketch or open any already created. 

From the FIspace menu bar, select the option My Sketches. 

 

Figure 97: Menu item to launch MySketches plugin 

Using the plugin 

This tool provides the possibility to draw in a panel different kind of figures, write text, 
draw lines, change the colour of the figures and text, fill figures, save the content of the 
panel or open an image file to modify. We can subdivide these tools in groups of func-
tionalities and describe how works each group. 

The first group that contains the basic options to draw are shown in the next figure: 

 

Figure 98: Basic options in MySketches 

Special options are Text and Rubber options.  

To use Text we need, firstly, click on the option and, with the right button of the mouse 
we can change the literal of the text that will appear in the screen. 
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Figure 99: Text option in MySketches (I) 

After this, we can press OK button and move the cursor in the desired position where 
we can insert the text and then, clicking left button of the mouse, the text is inserted. 

 

Figure 100: Text option in MySketches (II) 

Rubber erases a specific area of the screen. We must move the cursor to the initial po-
sition to erase and, moving the cursor from left to right, it begins to erase the content 
selected. 

 

Figure 101: Rubber option in MySketches 
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The next group of functionalities to consider is related to filling forms: 

 

Figure 102: Filling options in MySketches (I) 

Example of the result of apply Fill Options 

 

Figure 103: Filling options in MySketches (II) 
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The next group is related with the type of line, only applicable to lines, polygons, rec-
tangles and ellipses. 

 

Figure 104: Lines in MySketches 

The last group within in the main bar of options is Text Tool Font, where we can choose 
among different kinds of fonts and change the appearance, like bold, italic, etc. 

 

Figure 105: Text Tool Font option in MySketches 

 

Before to continue, it’s important to pay a mention about the main menu in the toolbar 

 

Into the File menu, we can find the next options:  
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Load opens a File dialog and allows to load and image file (only jpeg, jpg, gif or png 
files) from the local machine into the drawing panel. 

 

Figure 106: Load option in MySketches 

Save allows the user to save into the local machine the content of the panel in form of 
image file (only jpeg, jpg, gif or png files). 

 

Figure 107: Save option in MySketches 

Above figure shows the image saved as jpeg file. 

Into the Edit menu, we can find the next option:  
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Clear All option allows the user to clear the entire drawing panel 

The rest of the options located at the bottom of the screen are related with the colours 
of the lines and the filling of the figures.  

We can see two squares indicating the current chosen colour. Left square indicates the 
foreground colour applied to the lines and figures. Right square indicates the back-
ground colour or fill colour applied to the figures. 

 

Figure 108: Colour option in MySketches 

To select a colour is necessary to move the cursor with the mouse to the colours area. 

To select the Foreground colour, with the left button of the mouse, click over the chosen 
colour of the colour area and, immediately, the Foreground square shows the chosen 
colour. 

To select the Background colour, with the right button of the mouse, click over the cho-
sen colour of the colour area and, immediately, the Background square shows the cho-
sen colour. 

The last options are Airbrush Radio and Airbrush Intensity. Airbrush Radio determines 
the thickness or diameter of the brush and Airbrush Intensity determines the opacity of 
the brush. As you can know, these options only work with Airbrush Option from the 
dashboard. 

 

Figure 109: Airbrush options in MySketches 
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2.16 FIspace-SOAP Plugin 

From the Bar menu select File -> New Project -> SOAP Client Generator, you can open 
this wizard. 

 

Figure 110: FIspace SOAP tool 

If you want to generate a SOAP client from a file, choose the corresponding item. 

 

Figure 111: FIspace SOAP tool from file (I) 
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Click on Next button: 

 

Figure 112: FIspace SOAP tool from file (II) 

If you want to generate a SOAP client from an URL, choose the corresponding item. 

 

Figure 113: FIspace SOAP tool from URL (I) 
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Clicking on Next button: 

 

Figure 114: FIspace SOAP tool from URL (II) 
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2.17 FIspace-uploader Plugin 

This plugin provides the connection SDK to FIspace Store. FIspace projects with a 
widget nature (widget and decoupled widget projects) can be uploaded to FIspace 
Store. 

It is only available for widget nature projects, and the FIspaceStudio perspective being 
active. Right-click on a project containing a widget: 

 

 

Figure 115: FIspace Widget Uploader 

 

Selecting the FIspace (defaults) perspective, you can right-click on an app to be up-
loaded. Choose the FIspace entry from the menu and click in this order: 

 First, Generate Widget to generate the widget and to be validated. 

 Second, Upload Application to upload it (deploying and uploading). 

The results can be seen in Console view. Notice the “*.wgt” file just generated. 

 

Figure 116: FIspace Widget generation results 

 

Note: The uploading is currently under testing. 
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2.18 FIspace-wizard Plugin 

Select from the main menu File --> New --> Project. It will then appear a "Select Wizard" 
where it has to be chosen FIspace -> FIspace Project and click on Next. 

 

Figure 117: FIspace Project Wizard 

 

The next form will appear. 
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Figure 118: FIspace Project Wizard Form 

In the form it is mandatory to inform "Project Name" and "Project Type". Once those 
data are filled, click "Finish". Wait till the process is completed. Once it is completed, 
please refresh the new Project in the Package Explorer. 

 

Figure 119: Waiting for FIspace project creation 
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In case you are under a proxy, you will have to follow the next instructions: Select 
from the main menu the option "Window" and then select "Preferences". Go to "FIspace 
Studio --> Settings" and complete the form. 

 

Figure 120: FIspace Proxy Settings 

 

Next sections show several types of projects that can be created. 

2.18.1 Widget Project 

Widget refers to a small application with limited functionality that can be installed and 
executed within a web page by an end-user. The Widget project enables the develop-
ment of WireCloud projects [18], which is the platform in which these Widgets can be 
installed and executed. 

This simple project contains a single .html file with a “Hello World”. It is also necessary 
to provide a config.xml file containing instructions of how the WireCloud should install 
and execute the widget. The widget project was designed to work out of the box, that is, 
once the project is created it can be packaged as a Widget and published into Wire-
cloud directly, without needing to configure the index.html and config.xml files. 

A widget project is to be created: 
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Figure 121: FIspace Widget project 

After clicking on the Finish button, you obtain the following widget project structure. 

 

Figure 122: FIspace Widget project structure 

 

2.18.2 Compact Project 

The compact archetype also contains a Widget for WireCloud [18], but, unlike the 
Widget project, this one is more complex, with HTML5 features. The HTML template 
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Boilerplate2 was used to implement this Widget. According to the authors, this template 
helps you build fast, robust and adaptable web apps or sites. 

A compact project is to be created: 

 

Figure 123: FIspace Compact project 

 

After clicking on Finish button, you obtain the following compact project structure. 

 

Figure 124: FIspace Compact project structure 

 

  

                                            
2 http://html5boilerplate.com/ 
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2.18.3 Decoupled Project 

The decoupled project consists in two parts, the widget part and the backend part. The 
widget part is the same as the one provided by the Widget project. The backend part 
provides support to the widget part giving some java classes that can be used to con-
nect both sides. 

So that the backend part can connect to the Widget, the backend must be deployed by 
using a java-based application container, such as Jetty Web Server 
(http://www.eclipse.org/jetty/). 

The backend side contains a class called FIspaceClient.java, which prepares the 
backend to connect to FIspace through the SDI, importing the libraries eu.fispace.api. 

This class provides some examples of requests and responses to FIspace. 

A decoupled project is to be created. 

 

Figure 125: FIspace Decoupled project 

 

After clicking on Finish button, you obtain the following decoupled project structure. No-
tice the three resulting projects. 

http://www.eclipse.org/jetty/
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Figure 126: FIspace Decoupled project structure 

2.18.4 Node.js Project 

The Node.js project represents a basic Node.js project, which helps users to start cod-
ing. Node.js is a runtime environment and a library for running applications written in 
JavaScript outside the browser (for example, on the server). Node.js uses an event-
driven, non-blocking I/O model that makes it lightweight and efficient, perfect for data-
intensive real-time applications that run across distributed devices. 

The structure of the project is compatible to Node.js projects, and also compatible to 
Express [23], a web application framework for node, widely used. 

A node.js project is to be created. 

 

Figure 127: FIspace Node.js project 
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After clicking on Finish button, you obtain the following node.js project structure. 

 

Figure 128: FIspace Node.js project structure 

 

2.18.5 JavaFX Project 

JavaFX is a rich client platform for enterprise business applications. It reuses Java li-
braries and allows developers to access native system capabilities. The JavaFX project 
provides a basic JavaFX application to interconnect to FIspace capabilities through the 
SDI. To do that it uses the NotificationMessage class to send a basic message when a 
button is pressed in the Java GUI. 

A javaFX project is to be created. 
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Figure 129: FIspace JavaFX project 

 

After clicking on Finish button, you obtain the following javaFX project structure. 

 

Figure 130: FIspace JavaFX project structure 
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2.18.6 RCP app archetype 

RCP (Rich Client Platform) [27] constitutes the minimal set of plug-ins needed to build a 
rich client application (platform application with a UI). The RCP project enables Eclipse 
[27] to be used in a wide range of end-user applications that are not Integrated Devel-
opment Environments (IDEs). 

A RCP project is to be created: 

 

Figure 131: FIspace RCP project 

 

After clicking on Finish button, you obtain the following RCP project structure. 

 

Figure 132: FIspace RCP project structure 

 

After a successful new project generation with the wizard plugin, the next steps are re-
quired to launch the RCP App: 

1. Open plugin.xml file 
2. Click on “Launch an eclipse application”: 
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Figure 133: Launching FIspace RCP project 

3. Once the project is launched as an “Eclipse Application”, the application “Hello RCP” is 
displayed: 

 

Figure 134: Default RCP project GUI 
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2.19 FIspace-xmleditor Plugin 

Double click over config.xml file should open the config.xml file in the FIspace editor. 

FIspace XML editor provides structured form-based UI for viewing and editing Wire-
Cloud config.xml. 

 

Figure 135: FIspace XML-editor 

 
Form-based UI 

The form-based POM editor UI provides rich editing and navigation features. See figure 
above. 

 
Platform preferences 

 

Figure 136: FIspace XML Editor Form Platform preferences form 
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Platform StateProperties 

 

Figure 137: FIspace XML Editor Form Platform State Properties form 

 
Platform Wiring 

 

Figure 138: FIspace XML Editor Form Platform Wiring form 
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XML Editor Text View 

Text View remains the most popular XML editing view of FIspace, and we continue to 
add new features to facilitate XML development. Intelligent XML editing is provided with 
syntax colouring, code completion, context-sensitive entry helpers, and Smart Fix vali-
dation for automatically correcting validation errors (See Figure below). 

 

 

Figure 139: FIspace XML Editor Text 
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2.20 FIspace-logging Plugin 

In this plugin we have the following extensions (defined in plugin.xml): 

1. PreferencePages: 

 Entry in settings menu: Eclipse / Preferences 

 Let the user choose: 

o Logs file directory 

o Server Route 

o Username and password 

 Desirable (Filter levels, schemas of colours, …) 

 

 

Figure 140: Logging Settings 
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2. Views: 

FIspace Logging Plugin let users, among others, monitor logs from different FIspace 
projects in a single view (Java Perspective). 

 

Figure 141: FIspace Logging View 

 

3. Configure FIspace projects to use Logging Plugin: 

Prerequisites: 

1. Use SLF4J APIs for logging. Tested version (slf4j-api-1.7.7.jar). 

2. Use Log4j implementation of SLF4J. Tested version (slf4j-log4j12-1.7.7.jar). 

3. log4j.jar is required to use Property Configurator. 

4. All log messages will be stored in a local log file. Also it will be sent to console. 

 

Example of how to use Log4j implementation: 
package com.example.helloworld; 
 
import org.apache.log4j.PropertyConfigurator; 
import org.slf4j.Logger; 
import org.slf4j.LoggerFactory; 
 
public class HelloWorld { 
    /** 
     * Logger for this class 
     */  
final static Logger logger = LoggerFactory.getLogger(HelloWorld.class); 
 
public static void main(String[] args) { 
 
        PropertyConfigurator.configure("log4j.properties"); 
 
        logger.error("Log4j ERROR run successfully!!"); 
 
        logger.debug("Log4j DEBUG run successfully!!"); 
 
        logger.info("Log4j INFO run successfully!!"); 
 
        logger.warn("Log4j WARN run successfully!!"); 
 
    } 
}* 
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#Define the log4j configuration for local application 
log4j.rootLogger=DEBUG, CA, LOGFILE 
 
 
#Console Appender 
log4j.appender.CA=org.apache.log4j.ConsoleAppender 
log4j.appender.CA.layout=org.apache.log4j.PatternLayout 
log4j.appender.CA.layout.ConversionPattern=%d--%p--%c: (%13F:%L)--%m%n 
 
 
 
 
# LOGFILE is set to be a DailyRollingFileAppender appender using a PatternLayout. 
 
log4j.appender.LOGFILE = org.apache.log4j.DailyRollingFileAppender 
log4j.appender.LOGFILE.File=${user.home}/fispace-logs/logFile.log 
log4j.appender.LOGFILE.DatePattern='.'yyyy-MM-dd 
log4j.appender.LOGFILE.layout=org.apache.log4j.PatternLayout 
log4j.appender.LOGFILE.layout.conversionPattern=%d--%p--%c: (%13F:%L)--%m%n 
log4j.appender.FA.Threshold=DEBUG 

 

Figure 142: Configuring projects to use Logging Plugin 

 

5. Configure a logging server 

In “Eclipse preferences”, select the FIspace Logging Preferences: 

 

Figure 143: FIspace Logging preferences (defaults) 

Press the “Restore defaults” button to fill the fields with default values or write the corre-
sponding parameters: 

Default URL for the Logging server API is: http://gisai.dit.upm.es:3004/api/log 

New logs will be sent to the server automatically. 

 

http://gisai.dit.upm.es:3004/api/log
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6. Review logged logs 

For reviewing purposes, a web interface can be used to read saved logs in server. It 
allows reading sent logs and filtering them by upload user. 

Current URL is: http://gisai.dit.upm.es:3004. 

Choosing Logs option in the header will show the logs interface: 

 

Figure 144: FIspace Logging log server 

Filtering logs by user can be done searching in the box for a knowing user. Start typing 
in the box will display the found users which contain the typed string in their username. 
Clicking on the desired user and only logs of that user will show.  

An example is included in the next figure. 

 

Figure 145: FIspace Logging filtering by Username 

 

  

http://gisai.dit.upm.es:3004/
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2.21 FIspace Studio Tool  

The users can download the latest version of FIspace Studio for the operating system of 
their preference from this web page: http://37.131.251.110:8080/fispace-studio/  

 

Figure 146: FIspace Studio available versions 

The next “splash screen” appears once the FIspace Studio is launched for first time: 

 

Figure 147: FIspace Studio splash screen 

FIspace Studio has its own customised About dialog: 

 

Figure 148: FIspace About Dialog 

 

http://37.131.251.110:8080/fispace-studio/
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A custom intro or welcome page is provided with some web links pointing to FIspace 
documentation and tutorials: 

 

Figure 149: FIspace Intro page 

 

Once the FIspace Studio is started the user experience includes all of the FIspace SDK 
functionalities under the same IDE platform. 

 

Figure 150: FIspaceStudio Tool 
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3 Glossary 

The glossary provides the coherent terminological framework used in this document. 

3.1 Terms and definitions 

This section provides definitions of any terms that may be needed in order for the read-
er to understand the terminology used in the document. The author should define any 
definition/acronym or technical term used in the document that may be unfamiliar to the 
reader, and it is best to err on the side of too many rather than too few definitions. This 
also allows the author to frame a word within a specific context, which provides the 
reader with a common understanding of the author’s definition. 

Access control 

Authorisation (or denegation) for performing a certain action (based on privileges man-
agement). The access control is carried out once the Identification and Authentication 
procedures have been performed. 

Accounting 

Process of gathering information about the usage of resources by subjects. 

Acceptance and trust 

Acceptability indicates the degree of approval of a technology by the users. It depends 
on whether the technology can satisfy the needs and expectations of its users and po-
tential stakeholders. Within the framework of introducing new technologies, acceptability 
relates to social and individual aspects as well. 

Application 

Use of capabilities, including hardware, software and data, provided by an information 
system specific to the satisfaction of a set of user requirements in a given application 
domain. 

Application Domain 

Integrated set of problems, terms, information and tasks of a specific thematic domain 
that an application (e.g. an information system or a set of information systems) has to 
cope with. 

Application Schema [ISO/FDIS 19109:2003] 

Conceptual schema for data required by one or more applications. 

Architecture (of a system) [ISO/IEC 10746-2:1996] 

Set of rules to define the structure of a system and the interrelationships between its 
parts. 

Architecture (of a system) [ISO/IEC 10746-2:1996] 

Set of rules to define the structure of a system and the interrelationships between its 
parts. 

Authentication 
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Process of verifying the identity of a certain subject. In other words authentication indi-
cates whether a subject is who/what it seems to be. 

Generally speaking, this proof can depend on a secret that can be, e.g. what somebody 
has (key, smart card, …), what somebody knows (password, …), what somebody is 
(biometrical data, …) 

Authorisation 

Process of determining whether a subject is allowed to have the specified types of ac-
cess to a particular resource. This is done by evaluating applicable access control in-
formation contained in a so called authorisation context. Usually, authorisation is carried 
out after the identification and authentication. Once a subject is identified and authenti-
cated, it may be authorized (or not) to perform different types of access. 

Availability 

Availability refers to the degree to which a system, subsystem, or equipment is in a 
specified operable and committable state at the start of a mission, when the mission is 
called for at an unknown, i.e., a random time. So, availability is the proportion of time 
that a system is in operating condition. 

Capability 

Capabilities are a set of functionalities, through a combination of software and hard-
ware, used to provide services and data. They can reside in a system or for example in 
a terminal itself as embedded capabilities or they can be available through the network 
services and infrastructure and others communication technologies as external capabili-
ties. 

Catalogue [derived from 
http://www.opengeospatial.org/resources/?page=glossary] 

Collection of entries, each of which describes and points to a feature collection. Cata-
logues include indexed listings of feature collections, their contents, their coverages, 
and of meta-information. A catalogue registers the existence, location, and description 
of feature collections held by an Information Community. Catalogues provide the capa-
bility to add and delete entries. A minimum Catalogue will include the name for the fea-
ture collection and the locational handle that specifies where these data may be found. 
Each catalogue is unique to its Information Community. 

Certificate Authority 

A Trusted Third Party, responsible for ensuring the binding between the public keys and 
the personal data of their respective owners. 

Component 

Hardware component (device) or Software Component. 

Conceptual model [ISO/FDIS 19109:2003(E); ISO 19101] 

Model that defines concepts of a universe of discourse. 

Conceptual schema [ISO/FDIS 19109:2003(E); ISO 19101] 

Formal description of a conceptual model. 

Coverage [ISO 19123] 
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Function from a spatial, temporal or spatiotemporal domain to an attribute range. A 
coverage associates a position within its domain to a record of values of defined data 
types. Thus, a coverage is a feature with multiple values for each attribute type, where 
each direct position within the geometric representation of the feature has a single value 
for each attribute type. 

Data acquisition 

Methods of data acquisition include methods to collect background data, digitally ac-
quire data from sensors, and subjective data (such as data acquired from question-
naires). In addition, data in the form of manually or automatically transcribed data and 
reductions of collected data is also considered sensor acquired data (but with a manual 
sensor – the analyst). 

Description Logics 

Family of logic based knowledge representation languages that are a decidable subset 
of first order logic with well-defined semantics and inferencing (problem decision proce-
dures). In Description Logics, a distinction is made between the terminological 
knowledge and the assertional knowledge. This distinction is useful for knowledge base 
modelling and engineering: for modelling it is just natural to distinguish between con-
cepts and individuals; for engineering it helps by separating key inference problems. 

Digital Certificate 

A kind of digital document that contains structured information about the identity of its 
owner along with her/his public key, signed all together with a Certificate Authority’s pri-
vate key. 

Digital Signature 

The encrypted form of a message with the private key of the owner, indicating in a se-
cure way the creator of the message, as well as the identity of a signed data. 

Encryption 

The act of modifying the contents of a message in an algorithmic and secure way, so 
that it can not be observed or altered in while in transit. 

End-User 

All users that are involved in an application domain and that use the applications, the 
services built by the system users according to the system and service Architecture. 

Feature [derived from ISO 19101] 

Abstraction of a real world phenomenon [ISO 19101] perceived in the context of an Ap-
plication. In this general sense, a feature corresponds to an “object” in analysis and de-
sign models. 

Framework [http://www.opengeospatial.org/resources/?page=glossary] 

An information architecture that comprises, in terms of software design, a reusable 
software template, or skeleton, from which key enabling and supporting services can be 
selected, configured and integrated with application code. 

Generic 
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A service is generic, if it is independent of the application domain. A service infrastruc-
ture is generic, if it is independent of the application domain and if it can adapt to differ-
ent organisational structures at different sites, without programming (ideally). 

Identification 

The identification process allows relating a person/device with the service environment. 
The “electronic identity” is something like a credential or a “business card”, suitable to 
be verified throughout the authentication process. 

Implementation [http://www.opengeospatial.org/resources/?page=glossary]  

Software package that conforms to a standard or specification. A specific instance of a 
more generally defined system. 

Info-structure Service 

Service that is required to operate a system oriented service in the sense that it plays 
an indispensable role in the operation of an architecture or system oriented service. 

Interface [ISO 19119:2005; http://www.opengis.org/docs/02-112.pdf] 

Named set of operations that characterize the behaviour of an entity.  

The aggregation of operations in an interface, and the definition of interface, shall be for 
the purpose of software reusability. The specification of an interface shall include a stat-
ic portion that includes definition of the operations. The specification of an interface 
shall include a dynamic portion that includes any restrictions on the order of invoking 
the operations. 

Interoperability [ISO 19119:2005 or OGC; 
http://www.opengeospatial.org/resources/?page=glossary] 

Capability to communicate, execute programs, or transfer data among various function-
al units in a manner that require the user to have little or no knowledge of the unique 
characteristics of those units [ISO 2382-1]. 
(http://www.opengeospatial.org/ogc/glossary/i) 

Loose coupling [W3C; http://www.w3.org/TR/2004/NOTE-ws-gloss-
20040211/#loosecoupling] 

Coupling is the dependency between interacting systems. This dependency can be de-
composed into real dependency and artificial dependency: Real dependency is the set 
of features or services that a system consumes from other systems. The real depend-
ency always exists and cannot be reduced. Artificial dependency is the set of factors 
that a system has to comply with in order to consume the features or services provided 
by other systems. Typical artificial dependency factors are language dependency, plat-
form dependency, API dependency, etc. Artificial dependency always exists, but it or its 
cost can be reduced. Loose coupling describes the configuration in which artificial de-
pendency has been reduced to the minimum. 

Middleware [http://www.opengeospatial.org/resources/?page=glossary] 

Software in a distributed computing environment that mediates between clients and 
servers. 

Open Architecture [based on (Powell 1991)] [29] 

Architecture whose specifications are published and made freely available to interested 
vendors and users with a view of widespread adoption of the architecture. An open ar-
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chitecture makes use of existing standards where appropriate and possible and other-
wise contributes to the evolution of relevant new standards. 

Operation [ISO 19119:2005; http://www.opengis.org/docs/02-112.pdf] 

Specification of a transformation or query that an object may be called to execute. An 
operation has a name and a list of parameters. 

Performance indicators definition (PI) 

PIs are quantitative or qualitative measurements, agreed on beforehand, expressed as 
a percentage, index, rate or other value, which is monitored at regular or irregular inter-
vals and can be compared with one or more criteria. 

Platform (Service) 

Set of infrastructural means and rules that describe how to specify service interfaces 
and related information and how to invoke services in a distributed system. 

Reference Model [ISO Archiving Standards; 
http://ssdoo.gsfc.nasa.gov/nost/isoas/us04/defn.html] 

A reference model is a framework for understanding significant relationships among the 
entities of some environment, and for the development of consistent standards or speci-
fications supporting that environment. A reference model is based on a small number of 
unifying concepts and may be used as a basis for education and explaining standards 
to a non-specialist. 

Reliability 

Reliability is the ability of a system or component to perform its required functions in 
routine circumstances, as well as hostile or unexpected circumstances, under stated 
conditions for a specified period of time. 

Resource 

Functions (possibly provided through services) or data objects. 

Service [ISO 19119:2005; ISO/IEC TR 14252; http://www.opengis.org/docs/02-112.pdf] 

Distinct part of the functionality that is provided by an entity through interfaces. 

REST 

Representational state transfer (REST) is an abstraction of the architecture of the World 
Wide Web; more precisely, REST is an architectural style consisting of a coordinated 
set of architectural constraints applied to components, connectors, and data elements, 
within a distributed hypermedia system. REST ignores the details of component imple-
mentation and protocol syntax in order to focus on the roles of components, the con-
straints upon their interaction with other components, and their interpretation of signifi-
cant data elements. 

Service [ISO 19119:2005; ISO/IEC TR 14252; http://www.opengis.org/docs/02-
112.pdf] 

Distinct part of the functionality that is provided by an entity through interfaces. 

Session 

http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/Hypermedia
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Temporary association between a subject and a principal as a result of an authentica-
tion process initiated by the subject. Information about a session is stored in authentica-
tion session information. 

SOAP 

Simple Object Access protocol is a protocol specification for exchanging structured in-
formation in the implementation of web services in computer networks. It uses XML In-
formation Set for its message format, and relies on other application layer protocols, 
most notably Hypertext Transfer Protocol (HTTP) or Simple Mail Transfer Protocol 
(SMTP), for message negotiation and transmission. 

Software Component [derived from component definition of 
http://www.opengeospatial.org/resources/?page=glossary] 

Software program unit that performs one or more functions and that communicates and 
interoperates with other components through common interfaces. 

Source System 

Container of unstructured, semi-structured or structured data and/or a provider of func-
tions in terms of services. The source systems are of very heterogeneous nature and 
contain information in a variety of types and formats. 

Support Service 

Service that facilitates the operation of an architecture or system oriented service, e.g. 
providing an added value by combining the usage of Info-Structure Services. 

System [ISO/IEC 10746-2:1996] 

Something of interest as a whole or as comprised of parts. Therefore a system may be 
referred to as an entity. A component of a system may itself be a system, in which case 
it may be called a sub-system. 

Note: For modelling purposes, the concept of system is understood in its general, sys-
tem theoretic sense. The term "system" can refer to an information processing system 
but can also be applied more generally. 

System User 

Provider of services that are used for an application domain as well as IT architects, 
system developers, integrators and administrators that conceive, develop, deploy and 
run applications for an application domain. 

Terminal 

Terminals are a mobile device that is capable of running mobile services and/or mobile 
applications. 

Use case 

A common definition of use cases is the one described by Jacobson (Jacobson et al 
(1995) [30]): “When a user uses the system, she or he will perform a behaviourally re-
lated sequence of transactions in a dialogue with the system. We call such a special 
sequence a use case”. In Other words, a use case is a textual presentation or a story 
about the usage of the system told from an end user’s perspective. 

The use cases provide some tools for people, with different skills (e.g. software devel-
opers and non-technology oriented people), to communicate with each other. The use 

http://en.wikipedia.org/wiki/Protocol_(computing)
http://en.wikipedia.org/wiki/Web_service
http://en.wikipedia.org/wiki/Computer_network
http://en.wikipedia.org/wiki/XML_Information_Set
http://en.wikipedia.org/wiki/XML_Information_Set
http://en.wikipedia.org/wiki/Application_layer
http://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol
http://en.wikipedia.org/wiki/Simple_Mail_Transfer_Protocol
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cases are general descriptions of needs or situations that often are related to basic 
scenarios and that are independent of the technologies and implementations of the un-
derlying system. 

User 

Human acting in the role of a system user or end user of the service and system. 

WADL 

The Web Application Description Language is a machine-readable XML description of 
HTTP-based web applications (typically REST web services) WADL models the re-
sources provided by a service and the relationships between them. WADL is intended 
to simplify the reuse of web services that are based on the existing HTTP architecture 
of the Web. It is platform and language independent and aims to promote reuse of ap-
plications beyond the basic use in a web browser. 

Web Service 

Self-contained, self-describing, modular service that can be published, located, and in-
voked across the Web. A Web service performs functions, which can be anything from 
simple requests to complicated business processes. Once a Web service is deployed, 
other applications (and other Web services) can discover and invoke the deployed ser-
vice. 

W3C Web Service [W3C, http://www.w3.org/TR/2004/NOTE-ws-gloss-
20040211/#webservice]  

Software system designed to support interoperable machine-to-machine interaction 
over a network. It has an interface described in a machine-processable format (specifi-
cally WSDL). Other systems interact with the Web service in a manner prescribed by its 
description using SOAP-messages, typically conveyed using HTTP with an XML seriali-
zation in conjunction with other Web-related standards. 

 

 

http://en.wikipedia.org/wiki/XML
http://en.wikipedia.org/wiki/Hypertext_Transfer_Protocol
http://en.wikipedia.org/wiki/World_Wide_Web
http://en.wikipedia.org/wiki/Representational_State_Transfer
http://en.wikipedia.org/wiki/Web_service
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